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ORGANIZATION

1 ABOUT THIS MANUAL

This manual is set up to guide you through the step-by-step installation of your iMNP, so that you can follow it
through from the front to the back. Make sure you familiarize yourself thoroughly with the safety and security pre-
cautions detailed in Chapter 2 = before you begin to install your IMNP. TELES is not liable for any damage or injury
resulting from a failure to follow these safety and security instructions!

1.1 ORGANIZATION

This manual is organized into the following chapters.

= Chapter 1, "About this Manual” introduces the iIMNP Systems Manual and how it is set up.

» Chapter 2, “Safety and Security Precautions” describes the safety and security measures necessary
for smooth operation of your TELES.IMNP.

» Chapter 3, “System Overview" briefly describes the iIMNP and its implementation scenarios.

» Chapter 4, “iMNP Installation” contains information on basic installation and configuration of your
iMNP.

» Chapter 5, “Routing and Configuration” describes the iMNP’s individual configuration files and
parameters.

= Chapter 6, "iMNP User Interface” contains a description of the iIMNP’s user interface.

= Chapter 7, “Additional Routing Options” contains a description of additional routing options to
enable you to expand or fine tune the functionality of your iMNP.

= Chapter 8, “The iMNP Database” describes how to create and update the IMNP's database.

1.2 CONVENTIONS

This document uses the following typographic conventions:

» Bold - items from the GUI menu.

» Halfbold — items from the GUI and the menu.

» Code —file names, variables and constants in configuration files or commands in body text.

= "conventions" on page 4 = — cross-references can be accessed in the PDF files by a single mouse click.

Configuration data or extracts are written in single-column tables with a gray background.

1.3 SAFETY SYMBOLS

The following symbols are used to indicate important information and to describe levels of possible danger.

Note

Useful information with no safety implications.

iMNP 14, Revised: 2008.



SAFETY SYMBOLS

Attention

Information that must be adhered to as it is necessary to ensure that the system func-
tions correctly and to avoid material damage.

Warning

Danger. Could cause personal injury or damage to the system.

Dangerous voltage

Could cause injury by high voltage and/or damage the system.

DD D

Electrostatic discharge

Components at risk of discharge must be grounded before being touched.

iMNP 14, Revised: 2008.



SAFETY AND SECURITY PRECAUTIONS

2 SAFETY AND SECURITY PRECAUTIONS

Please be sure and take time to read this section to ensure your personal safety and
proper operation of your TELES infrastructure system.

To avoid personal injury or damage to the system, please follow all safety instruc-
tions before you begin working on your TELES infrastructure system.

TELES infrastructure systems are CE certified and fulfill all relevant security require-
ments. The manufacturer assumes no liability for consequential damages or for dam-
ages resulting from unauthorized changes.

This chapter applies for all TELES systems. Information that applies only for individual
TELES systems specifies the system for which it applies.

2.1 SAFETY MEASURES

Danger of electric shocks - the power supplies run on 230 V. Unplug the TELES infrastructure system from its power
source before working on the power supply or extension socket.

Make sure to install the system near the power source and that the power source is easily accessible.

Do not open the TELES infrastructure system except to install an additional TELES
component. Changes in the device are not permitted.

Wire your system using only the cables included in the package contents. Use only
proper ISDN and Ethernet cables.

Be sure to respect country-specific regulations, standards or guidelines for accident
prevention.

Bear in mind that telephone and WAN lines are also energized and can cause electric
shocks.

Do not insert foreign objects into openings in the device. Conductible objects can
cause short circuits that result in fire, electric shock or damage to the device.

2.2 TIPS FOR EMC PROTECTION

= Use shielded cables.
= Do not remove any housing components. They provide EMC protection.

iMNP 14, Revised: 12 June 2008.



SAFETY AND SECURITY PRECAUTIONS

2.3 SYSTEM SECURITY

This section describes all points crucial to the TELES infrastructure system’s system security.

The system'’s location must support normal operation of TELES infrastructure systems according to EN ETS 300 386.
Be sure to select the location with the following conditions in mind:

* Location: Make sure you install the system in a clean, dry, dust-free location. If possible, the site should
be air-conditioned. The site must be free of strong electrical or magnetic fields, which cause disrupted
signals and, in extreme cases, system failure.

» Temperature: The site must maintain a temperature between 0 and 45°C. Be sure to guard against
temperature fluctuations. Resulting condensation can cause short circuiting. The humidity level may not
exceed 80%. To avoid overheating the system, make sure the site provides adequate ventilation.

= Power: The site must contain a central emergency switch for the entire power source.

The site’s fuses must be calculated to provide adequate system security. The electrical facilities must
comply with applicable regulations. The operating voltage and frequency may not exceed or fall below
what is stated on the label.

» Antenna: iGATE contains no provision or protective device against power surges or lightning strikes. The
installation of the antenna must fulfill all necessary safety requirements. Employ the services of a
professional antenna installer.

2.4 SYSTEM SECURITY

Regular servicing ensures that your TELES system runs trouble-free. Servicing also includes looking after the room
in which the system is set up. Ensure that the air-conditioning and its filter system are regularly checked and that
the premises are cleaned on a regular basis.

2.4.1 REPLACING COMPONENTS

If your TELES system contains any of the following components, replace them according to the following table:

Table 2.1 Component life span

Component Life Span
Filter pads 6 months
Power adapter 5 years
Fan 5 years

iMNP 14, Revised: 12 June 2008.



SAFETY AND SECURITY PRECAUTIONS

2.4.2 PROTECTING THE OPERATING SYSTEM

Changing configuration data may lead to malfunctions and/or misrouting, as well as possible consequential dam-
age. Make changes at your own risk. TELES is not liable for any possible damage resulting from or in relation to
such changes. Please thoroughly check any changes you or a third party have made to your configuration!

Make sure your hard disk or flash disk contains enough storage space. Downloading the log files and deleting them
from the system on a regular basis will ensure your system's reliability.

Be careful when deleting files that you do not delete any files necessary for system operation.

Do not perform queries on the database. This can result in damages to the database. Do not use any MySQL tools,
such as MySQL-Front to make changes in or perform tests on the database.

2.5 NETWORK SECURITY

Every day hackers develop new ways to break into systems through the Internet. While TELES takes great care to
ensure the security of its systems, any system with access through the Internet is only as secure as its user makes
it. Therefore, to avoid unwanted security breaches and resulting system malfunctions, you must take the following
steps to secure your TELES system if you connect it to the Internet:

= Use an application gateway or a packet firewall.

= To limit access to the system to secure remote devices, delete the default route and add individual secure
network segments.

= Access to the system via Telnet, FTP, HTTP, iGATE Manager or remote vGateDesktop must be password
protected. Do not use obvious passwords (anything from sesame to your mother-in-laws maiden name).
Remember: the password that is easiest to remember is also likely to be easiest to crack.

The firewall must support the following features:

»  Protection against IP spoofing

» Logging of all attempts to access the system

The firewall must be able to check the following information and only allow trusted users to access the TELES
system:

= [P source address

= [P destination address

= Protocol (whether the packet is TCP, UDP, or ICMP)

= TCP or UDP source port

= TCP or UDP destination port

= |CMP message type

iMNP 14, Revised: 12 June 2008.



SAFETY AND SECURITY PRECAUTIONS

For operation and remote administration of your TELES system, open only the following ports only when the indi-
cated services are used.

Table 2.2 Default Ports Used for Specific Services

Service Protocol Port
For all systems except VGATE
FTP TCP 21 (default, can be set)
Telnet (for TELES debug access TCP 23
only)
SMTP TCP 25
DNS forward ubP 53
HTTP TCP 80 (default, can be set)
SNTP uDP 123
SNMP uDbP 161
H.225 registration, admission, sta- | UDP 1719 (default, can be set)
tus
H.225 signaling TCP 1720 (default, can be set)
Radius uDP 1812 (default, can be set)
Radius accounting uUDP 1813 (default, can be set)
GATE Manager TCP 4445 (default, can be set)
SIP signaling UDP / TCP 5060 (default, can be set)
RTP UDP 29000-29120 (default, can be set)
VGATE Control Unit TCp 57343
VGATE tunneling TCP 4446
For vGATE Control Unit and iMNP
FTP TCP 21
Telnet TCP 23
MySQL database TCP 3306
iGATE or TELES.VoIPBOX GSM/ TCP 57342
CDMA 4FX to vGATE
VGATE tunneling to iGATE or TCP 4446
TELES.VoIPBOX GSM/CDMA 4FX

iMNP 14, Revised: 12 June 2008.



SAFETY AND SECURITY PRECAUTIONS

Table 2.2 Default Ports Used for Specific Services (continued)

Service Protocol Port
iGATE or TELES.VoIPBOX GSM/ TCP 9003
CDMA 4FX to IMNP
Remote vGateDesktop TCP 57344
Remote vGateDesktop (read only) | TCP 57345
iIMNP TCP 9003
For vGATE SIM Unit
VGATE Control Unit plus iGATE or | TCP 51500
TELES.VoIPBOX GSM/CDMA 4FX
For NMS
FTP TCP 21
Telnet TCP 23
MySQL database TCP 3306
NMS protocol TCP 5000
NMS update TCP 5001
NMS task TCP 5002
NMS task TCP 5003
NMS Listen TCP 4444
For VGATE Call Manager
Radius authentication UDP 1812
Radius accounting ubp 1813

Connection from a vGATE Control Unit to an iGATE requires ICMP access. The TCP fil-
ters listed above are activated in the default configuration of the vGATE Control Unit

or the NMS server.

10

iMNP 14, Revised: 12 June 2008.



SYSTEM OVERVIEW

3 SYSTEM OVERVIEW

In most of the countries in the world, mobile carriers each have their own prefix. For end customers, this means
that they would have to change their mobile phone number when they switch to another carrier. Since this would
mean a significant reduction in competition, most countries require that carriers offer number portability. The result
is that many mobile phone users have numbers with prefixes for carriers other than their own.
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Ported Number LCR Extension is a function that enables you to map defined destination call numbers to other des-
tination numbers or networks. This function is used to allow telecommunications subscribers to change carriers
without having to change their telephone numbers.

Number portability is used in the fixed network, as well as in the mobile network. Usually the numbers are mapped
in their respective networks. Implementation of this information and the corresponding routing processes result in
significant cost savings, as tariff differences between calls to ‘normal” and ported subscribers are eliminated.

The database of ported numbers runs on the iMNP, which provides the data online for the entire network.

The system automatically routes calls through specific ports or to defined numbers, so that all calls through the
same carrier (including ported numbers) are routed through the port containing that carrier's SIM card as defined.

The iMNP can also access an external database to search for numbers it does not find in its own database. The
iIMNP automatically enters new numbers in its own database, so that the next call to the number will be routed
accordingly without having to access the external database.

iMNP 14, Revised: 12 June 2008.
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SYSTEM OVERVIEW

3.1 FEATURES

= Simple database generation and administration

= iMNP in proxy mode: communicate with an additional external database
= Numbers found in external database automatically entered in iIMNP

*  One database for all systems in the network

= Unlimited number of database entries

» No format restrictions for database entries

»  Gateway whitelists

= Generation of statistics

»  Automatically imports contents of text files to the database

3.1.1 SYSTEM REQUIREMENTS

Ported number screening requires the following:

iGATE/VoIPGATE running second generation software 11.4 or higher, or first generation software 6.00f or
higher and iLCR VolIP Board driver version 184 or higher

» An active license package for number portability
= AIMNP server
= Astatic IP address

iMNP 14, Revised: 12 June 2008.
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4 iMNP INSTALLATION

Implementation of individual scenarios requires adjustments to the appropriate in-
terfaces.

Use a UPS to avoid possible damage resulting from power interruptions.

4.1 NETWORK AND FIREWALL REQUIREMENTS

Before installing your iMNP, make sure you can fulfill the following network and firewall requirements:

= Message round-trip time must be less than 500 ms. You can use PING to measure the round-trip time.
= The iIMNP may be behind a PAT (Port Address Translation) firewall, as port 9003 may not be changed.
= Connection setup must be possible from iGATEs/VoIPGATEs to the iMNP at all times.

4.2 iMNP HARDWARE INSTALLATION

The iIMNP runs on a THU, 19" PC. iIMNP is a background server process with an attached MySQL
V. 4.0.22 database that communicates with VolPGATEs, iGATEs and with an optional external server.

Figure 4.1 provides a rear view of the iMNP. Connect the iIMNP to the Ethernet LAN1 Interface.

Power Mouse Ethernet

o - = -x
T ® LAN 1 LAN

Keyboard  Monitor

Figure 4.1 iMNP - Rear view

iMNP 14, Revised: 12 June 2008.
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5 ROUTING AND CONFIGURATION

5.1 CONFIGURATION OF THE iGATE AND/OR VolIPGATE

Before you get started, you must enter the following settings in the connected iGATEs and/or VoIPGATEs.

5.1.1 SECOND GENERATION CONFIGURATION

The following configuration applies only for iIGATE and VoIPGATE systems running second generation software ver-
sion 11.4 or higher. For a description of the configuration of first generation systems, see Chapter 5.1.2 on
page 15 =.

The NumberPortability section of the pabx.cfg file includes the parameters necessary for communication with the
iIMNP.

Table 5.1 Overview of the NumberPortability parameters

Parameter Description

MNPQAddress=<ip addr> Enter the iIMNP server's IP address.

MNPQPort=<port> Enter port 9003.

MNPQAddress2=<ip addr> | Enter the IP address to which the second number portability query is to be
sent when “!" appears in the mapping entry. A second iMNP will then be
queried, for example if the first on is not online.

MNPQPort2=<port> Enter port to which the second number portability query is to be sent.

MNPQSum=<mode> This parameter must be activated (Yes) if a IMNP is used.

Example 5.1 NumberPortability parameters in the pabx.cfg

[NumberPortability]
MNPQAddress=172.16.0.100
MNPQPort=9003
MNPQSum=Yes

iMNP 14, Revised: 12 June 2008.
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ROUTING AND CONFIGURATION

5.1.2 FIRST GENERATION CONFIGURATION IN THE TIB.CFG

The following configuration applies only for iIGATE and VolPGATE systems running first generation software 6.00f
and iLCR VolP Board driver Version 184. For a description of the configuration of second generation systems
(cf. Chapter 5.1.1 on page 14 =).

The System section of the tib.cfg file includes the parameters necessary for communication with the iMNP..

Table 5.2 Overview of the System parameters

Parameter Description

MNPQ: <mode> Enter Yes to activate the iMNP.

MNPQAddress:<ip addr> | Enter the iIMNP server's IP address.

MNPQPort:<port> Enter port 9003.

MNPQSum: <mode> This parameter must be activated (Yes) if a iIMNP is used.

Example 5.2 System parameters in the tib.cfg

[System]

MNPQ:Yes
MNPQAddress:172.16.0.100
MNPQPort:9003
MNPQSum:Yes

5.1.3 CONFIGURATION IN THE ROUTE.CFG

The configuration described here is for all compatible iGATE and VolPGATE systems.
The following routing entry in the route.cfq file is required to activate an iMNP query:
MapAll<num>=|D@<num><<01

If you use digit collection, it must appear before the database request in the routing configuration (for a description
of digit collection, see the chapter "Digit Collection” in the iGATE/VoIPGATE Systems Manual). A $ placeholder
mapping results in a subsequent iIMNP query:

MapAll<num>=| $ph<<<count>
MapAllph=|D@<num><<01

The routing entries for the iIMNP results contain the keyword QN, followed by the query result, an equal sign and
the controller:

MapAllQN<query>=<controller>

iMNP 14, Revised: 12 June 2008.
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ROUTING AND CONFIGURATION

The following example uses digit collection (11 digits plus $ph). Every incoming call with a leading digit of 0 results
in an iIMNP query. The SIM-card LAINs are used instead of controller numbers. All numbers that come back from
the IMNP with the LAIN for Carrier_1(26211) are then routed through Carrier_1's SIM card with CLIR. The same
applies for Carrier_2 (26212), Carrier_3 (26213) and Carrier_4 (26214). Numbers that the iMNP sends back as
non-existing in the iIMNP database (00000) are rejected. Numbers that are not found in the external database or
numbers that could not be found because of a failed connection to the external server (99999) are routed as they
come in (normal). If the iIMNP does not respond within two seconds (D@0), the call is routed as it comes in, wheth-
er it is ported or not:

Example 5.3 Parameters in the route.cfg

DTMFwWaitDial=5
MapAll0=| $ph<<14
MapAllph=|D@0<<01

MapAl1l1QN26211=#26211
MapAllQN26212=#26212
MapAllQN26213=#26213
MapAl1lQN26214=#26214
MapAl1QNOOO00=&81
MapA11QN99999=$normal
MapAl1D@O=$normall

; not in Database
;Carrier 1
MapAllnormal@151=#262110151
MapAllnormal0160=#262110160
MapAllnormal0170=#262110170
MapAllnormal@171=#262110171
MapAllnormal0175=#262110175
;Carrier 2
MapAllnormal0152=#262120152
MapAllnormal0162=#262120162
MapAllnormal0172=#262120172
MapAllnormal@173=#262120173
MapAllnormal0174=#262120174
;Carrier 3
MapAllnormal@155=#262130155
MapAllnormal0163=#262130163
MapAllnormal0177=#262130177
MapAllnormal@178=#262130178
;Carrier 4
MapAllnormal0159=#262140159
MapAllnormal@176=#262140176
MapAllnormal@179=#262140179

5.2 SETTING UP AND MAINTAINING THE iMNP DATABASE

iIMNP entries are maintained in text files. Each entry appears on a separate line containing the dialed number, a
comma followed by the new five-digit ported carrier prefix (referred to in this document as LAIN) and destination
numbers. You can either repeat the number after the LAIN or simply enter a +. The iMNP will interpret both entries
in the same way. iIMNP entries can appear in any order and be of any length:

<num>, <LAIN><num>
or: <num>,<LAIN>+

iMNP 14, Revised: 12 June 2008.
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ROUTING AND CONFIGURATION

The iIMNP is divided into two tables. One contains individual direct numbers that are to be ported to a defined LAIN.
The other table contains partial numbers; all numbers beginning with the digits entered here will be ported to the
defined LAIN. These two tables are maintained in separate files.

In the following example of direct portability, only the carrier is ported. No call-number conversion occurs:

Example 5.4 iMNP entries for direct portability

11721234567,26211+
11712345671,26212+
11775671234,26212+
11546712345,26217+
11743456712,26213+
11734567123,26217+

In the following example of partial portability, all calls beginning with the defined digits are ported as configured:

Example 5.5 iMNP entries for partial portability

11721234,26211+
1171234567,26212+
117756,26212+
1154671,26217+

You can import and export the tables to and from the text files from the File menu. You can import partial tables
that contain only individual new or changed entries. In this case it is not necessary to export the tables first.

By selecting Settings from the Options menu, you can also set the iIMNP to import the files automatically
(cf. Table 6.1 on page 19 = ).

iMNP 14, Revised: 12 June 2008.
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6 iIMNP USER INTERFACE

The iIMNP application is used to record and display a log of activity and for administration of the server.

The file iNumPortCtrl.exe islocated in the folder D: \NumberPortability. The Windows desktop con-
tains a link to this file. Double-click this link to start the iMNP.

s, TELES.iMNP =] B3
File Yiew DOptionz Help

0B-4pr-06 134243 GATEWaAY SERVER [DBG] External Successfully connected to 135.4.13.152]

OE-Apr-06 13:44:54 GATEWaY SERVER [DBG] GW 172.20.25.124:65463 - Connected

OE-Apr-06 134454 GATEWAY SERVER [DBG] GW172.20.25.124:665463: ] Mumber(z) asking: 01735667

OE-Apr-06 13:44:54 GATEWAY SERVER [DBG] GW[172.20.25.124:65463:] Parted number found: 01795667-> M 2620701735667
0E-Apr-06 1346: 23 GATEWAY SERVER [DBG] GW[172.20.25.124:65463: ] Mumber(z) azking: 01795667

0E-Apr-06 1346: 23 GATEWAY SERVER [DBG] GW[172.20.25.124:65463:] Parted number found: 01735667-> M 2620701735667
0E-Apr-06 134708 GATEWAY SERVER [DBG] GW[172.20.25.124:65463: ] Mumber(s) asking: 01795667

0E-Apr-06 13:47.08 GATEWAY SERVER [DBG] GW[172.20.25.124:65463:] Parted number found: 01735667->M 2620701735667
0B-Apr-06 13:47.57 GATEWAY SERVER [DBG] GW172.20.25.124:65463:) Mumber(z) asking: 01735667

0B-Apr-06 13:47.57 GATEWAY SERVER [DBG] GW172.20.25.124] External: Ported number found: 01738667 -» 42620701 735667
OE-Apr-06 13:48: 26 GATEWaY SERVER [DBG] GW172.20.25.124:65463: ] Mumber(s) asking: 01735667

OE-Apr-06 13:48: 26 GATEWAY SERVER [DBG] GW172.20.25.124:65463:] Ported number found: 01735667-> M 2620701735667
OE-Apr-06 13:49:50 GATEWAY SERVER [DBG] GW172.20.25.124:65463: ] Mumber(z) asking: 01795667

OE-Apr-06 13:49:50 GATEWAY SERVER [ERR] G'W[172.20.25.124] External: Ported number not found: 01795667 -» 00000007 795667
0E-Apr-06 13:49.56 GATEWAY SERVER [DBG] GW[172.20.25.124:65463: ] Mumber(z) azking: 01795667

0E-Apr-06 13:49:56 GATEWAY SERVER [ERR] GW[172.20.25.124] External: Ported number not found: 01795667 -» 00000001 7956671
0E-Apr-06 1350:13 GATEWAY SERVER [ERR] External not connected to 195.4.12.152 ERROR:[100E1]1

0E-Apr-06 135016 GATEWAY SERVER [DBG] GW[172.20.25.124:65463: ] Mumber(s) asking: 01795667

0B-Apr-06 13:50:16 GATEWAY SERVER [ERR] GW172.20.25.124:65463:] Parted number not found: M3333301 795667 ->M9333301 795667)
OB-Apr-06 136017 GATEWAY SERWVER [ERR] External not connected bo 195.4.13.152 ERROR:[100E1]]

< | i

| Queries [Extemall 16 5] |Successiul 13[81.25%) |Unsuccesstul 3[18.75%) s

If you close the interface, you can then open the iIMNP user interface by double- or right-clicking the icon

01
the right side of the taskbar.

The log contains up to 2500 lines describing all activity on the iIMNP. After the log has reached 2500 lines, the
oldest entries are deleted. All entries are written into the log file, which is generated every day at midnight.

The file is then saved here: D: \NumberPortability\logfiles.

iMNP 14, Revised: 12 June 2008.
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iMNP USER INTERFACE

The menu bar contains the following:

Table 6.1 iIMNP user interface menu bar

Item Description
File Menu
Export Database Select one of the following to export iIMNP entries to a text file:

Direct Portability Click here to export the table of complete individual numbers.
Partial Portability Click here to export the table of partial numbers.

Import Database Select one of the following to import entries from a text file to the iIMNP:

Direct Portability Click here to import the table of complete individual num-
bers.

Partial Portability Click here to import the table of partial numbers.

Exit Click here to close the iIMNP.
View Menu
Query Statistics Click here to open a window containing statistics about all gateway queries. Click

Query Statistics in the View menu to select the dates you want to display. If you
click Show Sums Only, only sums will be shown. Statistics are generated daily at
midnight. Statistics from the current and previous month are saved in the database.
The following statistics appear in the window:

IP Address Lists the gateway's IP address

Date Lists the date the statistics were generated

Queries Lists the total number of queries for the day

Successful Lists the total number of successful queries, followed
by the percentage

Unsuccessful Lists the total number of unsuccessful queries, fol-

lowed by the percentage

Internal Successful Lists the total number of successful queries to the
iIMNP, followed by the percentage

Internal Unsuccessful  Lists the total number of unsuccessful queries to the
iIMNP, followed by the percentage

External Successful Lists the total number of successful queries to an ex-
ternal provider, followed by the percentage

External Unsuccessful  Lists the total number of unsuccessful queries to an
external provider, followed by the percentage

Last Query Lists the time for last query was made by the gateway

Status Bar Click here to display or hide the status bar.
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Table 6.1 iIMNP user interface menu bar

Item Description

Options Menu

Log Settings This option allows you to select what kind of log entries you would like.
Default settings are Error and Debug. Select Detail to receive detailed entries.

Settings
Settings x|
% Use External Query — Automatic Impart
Address: I1?2.1B.‘I.‘I File Estension: !mnp
Fort I53 v Diirect Portabiliy
Tpe:  © Provider 1 Path: |D:\NumberPortability\portabilit_l,l |
% Provider 2 Service Profile: IB vl ¥ Partial Portability
International Prefix: IDD Path: |D:\NumberF‘ortabiIity\paltial |
¥ Delete Direct Portability Entries ————————————
Qlder Than IBD Days v lanare First |1 'I Digits
Ok I Cancel |

Check Use External Query to query external databases when the corresponding
checkbox is active. Any new numbers found in the external database are automat-
ically entered in the iIMNP. Enter the external server's IP Address and the Port
used for the connection. Provider 1 queries occur via TCP interface. Provider 2
queries occur via DNS interface. If you select Provider 2, you must set the Service
Profile defined by the provider. Queries to Provider 2 must include the country
code. Enter the prefix for international numbers in the International Prefix box.
The iIMNP will automatically enter any numbers that result from these queries in the
database.

If you activate the checkbox Delete Direct Portability Entries, the resulting en-
tries will be deleted following the number of days entered in the corresponding
box. This option can also be activated by right-clicking the iMNP icon on the right
side of the taskbar.

In the Automatic Import group box, you can define the path to a directory that
contains a file with the extension .mnp (default) or .txt. Depending on which check-
box(es) are activated, the iIMNP will import the contents of the file in the directory
to the Direct Portability and/or the Partial Portability database(s)

(cf. Chapter 5.2 on page 16 =). If you activate both, you must create different
folders for direct portability and partial portability. After that, the files will be re-
named as follows: <name>_<date>_<time>.old. The IMNP checks for a new file
in the directory every ten minutes.

If you activate the option Ignore First Digits, the iMNP will ignore the first 1-5
digits in its search, depending on the number of digits you define.
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Table 6.1 iIMNP user interface menu bar

Item

Gateway Whitelist

Description
Click here to define gateways you want to :
- x|

allow to query the iIMNP server. Double-

. . . . |P Addiess © | Cormment |
click or right-click to open the editor, from 182.168.0.101 Gw1
which you can add, edit or delete gateways | 1a510ap 105 o
from the list. Leave the Gateway Whitelist
empty to allow queries from all gateways.

Cancel |

Reset Statistics

Select this option to reset the statistics in the status bar.

Delete Direct Portability
Table

When you select this option, you will delete all of the entries in the direct portability
table.

Delete Partial Portability
Table

When you select this option, you will delete all of the entries in the partial porta-
bility table.

Delete Entries in Direct
Portability Table

When you select this option, you can enter individual numbers in the dialog that
appears to delete them from the iMNP.

Help Menu

About iIMNP

Click here to open a window with iMNP version information.
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7 ADDITIONAL ROUTING OPTIONS

7.1 BACKUP iMNP

Enter the following additional parameter in the pabx.cfg to query a backup iMNP if the first IMNP does not respond:

MNPQAddress2=<ip addr>
MNPQPort2=<port>

Example 7.1 Parameter for iMNP backup

[NumberPortability]
MNPQAddress=172.16.0.100
MNPQPort=9003
MNPQAddress2=172.16.0.101
MNPQPort2=9003
MNPQSum=Yes

An exclamation point (!) in the ROUTE.CFG is the keyword for sending the request to the second iIMNP:
MapAllD@<num>=|D@!<num><<01

The following example uses digit collection (11 digits plus $ph). Every incoming call with a leading digit of 0 results
in a database query to the iIMNP with the IP address 172.16.0.100. The SIM-card LAINs are used instead of con-
troller numbers. All numbers that come back from the iMNP with the LAIN for Carrier_1(26211) are then routed
through Carrier_1's SIM card with CLIR. The same applies for Carrier_2 (26212), Carrier_3 (26213) and Carrier_4
(26214). Numbers that the iMNP sends back as non-existing in the iIMNP database (00000) are rejected. Numbers
that are not found in the external database or numbers that could not be found because of a failed connection to
the external server (99999) are routed as they come in (normal).
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If the IMNP does not respond within two seconds (D@! @), a backup iIMNP will be queried. The routing entries for
the second iIMNP also contain an exclamation point “!" and follow the same syntax as those for the first IMNP.

Example 7.2 Sample configuration for iMNP backup

MapAll0=| $ph<<14
MapAllph=|D@0<<01

MapAl1lQN26211=#26211
MapAl1QN26212=#26212
MapAllQN26213=#26213
MapAl1lQN26217=#26214
MapAl1QNO0000=&81
MapAl1QN99999=$normal
MapAl1D@0=|D@!0<<01

MapAllQ!N26211=#26211
MapAllQ!N26212=#26212
MapAllQ!N26213=#26213
MapAllQ!N26217=#26214
MapAllQ!N00000=&81
MapAl1Q!N99999=$normal
MapAllD@!0=%$normal

;Carrier 1
MapAllnormal0151=#262110151
MapAllnormal0160=#262110160

7.2 DIFFERENT QUERY DESTINATIONS FOR DIFFERENT CALL NUMBERS

Enter the following additional parameter in the pabx.cfg to query one iIMNP for some prefixes and another iMNP
for others:

MNPQAddress2=<ip addr>
MNPQPort2=<port>

Example 7.3 Parameter for different query destinations for different call numbers

[NumberPortability]
MNPQAddress=172.16.0.100
MNPQPort=9003
MNPQAddress2=172.16.0.101
MNPQPort2=9003
MNPQSum=Yes

You can also use the exclamation point “!" in the route.cfg to send some numbers to one iMNP and others to a
second iIMNP.
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In the following example, all numbers beginning with 00 (international) are sent to the first IMNP (172.16.0.100).
Numbers beginning with 0 (national) are sent to the second iIMNP (172.16.0.101). Calls with numbers that come
back from the first IMNP with 11111 are routed through controller 40 to the VolP carrier Carrier_1. Calls with num-
bers that come back from the first IMNP with 22222 are routed to the VolP carrier Carrier_2. All international num-
bers that are not found are routed unchanged through the PSTN controller (9). National calls that are sent to the
second iIMNP are terminated through the PSTN using the carrier prefix 12345 if 12345 comes back from the iMNP.
If 54321 comes back, the carrier with the prefix 54321 is used. If 99999 comes back, national calls are terminated
unchanged through the PSTN. All local calls are routed unchanged through the PSTN.

Example 7.4 Sample configuration for different query destinations for different call numbers

MapAll00=|$ph<<14
MapAll0=|$sh<<14
MapAll1=91
MapAl12=92
MapAl13=93
MapAll14=94
MapAl15=95
MapAl16=96
MapAll7=97
MapAl118=98
MapA119=99

MapAllph=|D@00<<01
MapAllsh=|D@!0<<01

MapAllQN11111=40Carrier 1:
MapAl1QN22222=40Carrier 2:
MapAl11QNO00000=&81
MapA11QN99999=$normal
MapAl1D@0=960

MapAl1Q!N12345=912345
MapAl1Q!N54321=954321
MapAl1Q!NO0OBO=&81
MapAl1Q!N99999=$normal
MapAllD@!0=90

MapAllnormal=9
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8 THE iMNP DATABASE

8.1 UPDATING THE iMNP DATABASE

To update the database NumPortDB, you must first close the program iNumPortCtrl.exe.

The following instructions update Version 1.0 to 14.0. If you are updating to or from another version, enter the
relevant version numbers in the appropriate places.

iMNP Version 14.0 is compatible only with MySQL Version 4.0.X.

= Stop the WinMysqlAdmin Service by right-clicking the icon in the right-hand corner of the taskbar

and selecting WinNT | Stop the Service from the context menu. The traffic light will then turn red.

»  Restart the WinMysglAdmin Service by selecting WinNT | Start the Service from the same context menu,
so that the traffic light turns green.

= Start the MSDOS command prompt at Start | Programs | Accessories | Command Prompt

» Enter D: and press Return

» Enter cd mysql\bin and press Return

» Entermysql -u simdbuser -p and press Return

= Enter password:simdb and press Return

» Enter the command \ . (backslash period space) and enter the path to the script (in this example, on the
E: drive):

* E:\NumPort-Files\V14.0\NumPort DIFF V10 V140.sql
= Press Return

» Enter exit to exit mysql

= Stop the WinMysglAdmin Service by right-clicking the icon in the right-hand corner of the taskbar

and selecting WinNT | Stop the Service from the context menu. The traffic light will then turn red.

» Restart the WinMysglAdmin Service by selecting WinNT | Start the Service from the same context menu,
so that the traffic light turns green.

= Remove the old file iNumPortCtrl.exe from the installation folder D: \NumberPortability, as
well as the shortcut from the Windows Desktop. You «can also delete the folder
D:\NumberPortability if you like.

» Run the file Setup. exe from the folder that contains the new Version (E: \NumPortFiles\V14.0).

» Inthe Setup Wizard, click Browse and select the installation folder D: \NumberPortability. Select
installation for Everyone. Continue by clicking Next until you have the option to Close the Setup Wizard.
A shortcut to iNumPortCtrl.exe will automatically appear on the Windows Desktop.

= You can now start iNumPortCtrl.exe.
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8.2 CREATING A BACKUP OF THE iMNP DATABASE

To secure your database, we strongly recommend that you create a backup.

To create a backup of the database, create a directory E:\BackupDB and copy the database F:\mysql\da-
ta\NumPortDB into the new directory.

To distinguish between different database versions, rename the database to include the version number in the
name. To find the version number, select About iIMNP from the Help menu of the iMNP.
Example:

You want to create a backup for Version 1.0. The path for the backup database will be:

E:\BackupDB\NumPortDB10
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